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Tableau Public Workshop Handout 
This handout was developed with Tableau 2018.1 by Jane Zhao, 

 janezhao@rice.edu on Monday, June 24, 2019. 
Outline 

1. Workshop objectives 
2. Introduction 
3. Preparing Data: Data extraction and transformation 
4. Using Tableau Public 

I. Connect to your data 
II. Create a chart (i.e. a basic view) 

III. Use the Marks card to add depth to your chart 
IV. Drill down into the data 
V. Filter data from your view 

VI. Use Dashboard to uncover key insights 
VII. Use Story to present your analysis 

VIII. Save and publish your work 
 
Objectives 
Participants will be able to  

1) tell the limitations of Tableau Public  
2) connect to an Excel file  
3) create a worksheet, a dashboard, and a story 
4) know how to create group, hierarchy, and filter 
5) understand how Tableau manipulate data and how Tableau works 
6) save work to Tableau Public website  
7) share the created charts 

 
Introduction 

• Tableau is a data visualization tool that can help you understand data and 
discover insights of data.  With Tableau, you can create beautiful charts, graphs, 
dashboards and share them with other people conveniently.  

• Tableau products 
o Tableau Desktop 

§ The full version of Tableau.  
§ It can connect to a wide array of data sources. 
§ It has very strong security for data. 
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§ Tableau Desktop is free for students and instructors around the 
world. See Tableau Academic Programs for more information at 
https://www.tableau.com/academic. 

o Tableau Prep 
§ A brand new data preparation product designed to empower people 

to quickly and confidently combine, shape, and clean their data. 
§ Released in April 2018. 

o Tableau Server 
It is for an organization analytical use, available to those who can support 
a server that is dedicated to Tableau. There's a very large financial 
investment for an organization having this version.  

o Tableau Online 
It is the cloud solution for an organization. It doesn't require a large 
investment of money into a server. It needs accounts setup.   

o Tableau Public 
Tableau Public is a free solution/service from Tableau Software Company. 
It involves two products. 
§ Tableau Public (Desktop) – the free version of Tableau Desktop 

with limitations. 
• The work can’t be saved locally. The work can only be saved 

to the Tableau Public website (i.e. Tableau Public Server). 
Data privacy caution: Make sure you remove any 
security sensitive data such as SSN and ID or personal 
data such as name and DOB before you save and 
publish a workbook. 

• It works with data from Microsoft Excel, Microsoft Access, 
multiple text file formats, statistical files, Google sheets and 
web data connectors. 

• A free Tableau Public account is limited to 10GB online 
storage and 15,000,000 rows of data per workbook. 

§ Tableau Public (Server): It is the free version of Tableau Server 
hosted by Tableau Software company. It requires all workbooks are 
feely accessible to everybody.  

§ To use Tableau Public, 
• Create an account on Tableau Public at 

https://public.tableau.com/s/  
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• Download Tableau Public (Desktop) at 
https://public.tableau.com/s/download 

§ Tableau Public FAQ  
https://community.tableau.com/docs/DOC-9135 

o Tableau Academic Programs 
§ Tableau Desktop and Tableau Prep is free for students and 

instructors around the world.  
Read more at 
https://www.tableau.com/academic#8PcZYr0tkUl2ZvFG.99 

§ Tableau for Students 
Students (K12 and postsecondary) at accredited academic 
institutions worldwide are eligible for a free one-year license to 
activate Tableau Desktop and Tableau Prep. Fill out a form at  
https://www.tableau.com/academic/students#form 

 

Preparing Data:  Data Extraction and Transformation 
Preparing data can be very time consuming and intimidating! Your data needs to be 
correctly prepared. If the data is not prepared correctly, it will be hard for Tableau to 
recognize and utilize for analyses. Fortunately, we don’t have to do anything for the data 
used in this workshop. The DMC equipment circulation data set is ready for use. It was 
prepared by Mang Sun, Fondren System Librarian. He extracted the data from Sirsi’s 
system log file, and transformed it into an Excel spreadsheet file. 

The Tableau Workflow 

I.  Connect to your data 
1) Load a data file 

The first step is to connect to the data you want to explore or visualize. Launch Tableau 

Public . 
a. Connecting to a data file 

• Loading a local Excel file. 
1) On the left hand side blue navigation area, Connect 

a. To a File 
b. Excel -> , locate the .xls file you want to open 

2) Or File -> Open, locate the .xls file you want to open. 
• Loading an online Google Sheet 

o To a Server 
o More… -> Google Sheets 
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o Input your Google Account and password 
o Tableau will ask to have access to:  

 
o Click Allow to continue 

 
o Then select the Google Sheet you want to connect, click Connect to 

continue. 
• Once the file is connected successfully, you will see Tableau load the first 

1000 records for preview.  
2) Change data type 

After the data is connected, the column headers from your data source are shown as 
fields. Tableau assigns each field a data type. The data type reflects the kind of 
information stored in that field, for example, dates (9/18/2017) and strings (“Rice 
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University”). In this DMC equipment circulation data set, User Profile is set to String, 
User Cat1 is set to String too. However, Time Charge is set to String (Abc), which is 
wrong. The wrong default data type needs to be corrected. Click the Abc symbol above 
Time Charge and select Date and Time. 

 
 
The table below shows the Data Types in Tableau. 

Icon Data type 

 
 
Text (string) values 

 Date values 

 Date & Time values 

 Numerical values 

 Boolean values (relational only) 

 Geographic values (used with maps) 

Note: Tableau is only referencing the source data. When you work the data within Tableau, your 
underlying data won’t be affected (i.e. Your original source data remains intact.).  
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II.  Create a Chart (i.e. a basic view) 

Tableau workspace  

 
http://onlinehelp.tableau.com/current/pro/desktop/en-us/environment_workspace.html 
 
 Activity 2.1   Understanding the Data Pane  

1) Click Sheet 1 at the left bottom next to Data Source. 

  
2) After the data is loaded, the column headers from your data source are shown as fields 

on the left side in the Data pane. 
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3) Tableau puts each field into Dimensions or Measures. 
a. Dimensions typically hold categorical data that can’t be aggregated such as 

title/call numbers, dates or boolean values. Dimensions set the granularity, or 
the level of detail in the view. We typically want to group our data by some 
combination of categories. What dimensions we use to build the view will 
determine how many marks we have. 

b. Measures hold numeric data that can be measured and aggregated such as 
number of checkouts and sales. They’re aggregated up to the granularity set 
by the dimensions in the view. The value of a measure therefore depends 
on the context of the dimensions.  

c. Dimensions come out onto the view as themselves, measures come out 
onto the view as aggregates, discrete pills are BLUE, continuous pills are 
GREEN. 

d. Dimension fields are generally used for row or column headings. Measures are 
generally used for plotting or giving values to the sizes of markers. 

4) Tableau also automatically generates Number of Records, a field that counts the 
number of rows. The table loaded via the Excel sheet doesn’t contain any explicit 
measure. However, each line corresponds to a checkout (charge) event, Tableau 
automatically generates Number of Records that is a measure.  

5) Now rename Number of Records to Number of Charges by clicking the Down Arrow 
to the right of the measure and selecting Rename. 



 9 

 
 

Activity 2.2.01   Understand how Tableau manipulates data  
Question: How to break down the total number of charges by year by User Profile? 

1) Drag Number of Charges to the view area, you will see a number 13,178 in the view.  
When we drop a field on the Drop field here grid, we are creating a view from a tabular 
perspective. 

 
 

2) If you right click over the number, choose View Data…->Full Data, scroll to the column 
Number of Charges, you will see value 1 in all the rows in that column. What Tableau is 
doing here is to adding up every single value in this column in this dataset and giving us 
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a SUM number, which is the count of the rows as well.  

 
3) If we want to see the year in this view, double click on Time Charge, which will be 

added to Columns shelf. Now we have broken down our single number into three 
numbers. Basically we have sliced the aggregated number by year. When we add a 
dimension to the view, members of that dimension will be added as column or row 
headers. 
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4) If we would rather have row headers, we can drag the YEAR pill to Rows.  

 
Drag YEAR pill back to the Columns shelf.  

5) If we would like to put User Profile, we double click it to add it into the view. Now we see 
we have further broken down the three numbers. We got a table of 13 rows and 
columns, including 29 numbers and 10 null values.   

 
6) At any time, you can right click over a number and choose View Data… to view the 

underlying sliced data.  
7) You can drag both YEAR pill and User Profile to either Columns shelf or Rows shelf. 

However, this probably will generate either too long or too high table that you have to 
scroll to view. That’s what you want to avoid.  

8) Right click over Sheet 1 and rename it to DMC-Charges-byYear-byUserProfile-Table. 
9) Optional steps 

a. Click on Show Me on the upper right corner. 
b. Choose stacked bars, you get a stacked bar chart.  
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Activity 2.2.02   Understand Show Me menu  
1) Consider Show Me to be your expert helper. Show Me tells you what chart to 

use and why.  
2) Show Me menu lists 24 common chart types. Some of them will be available. 

Some of the them will be greyed out depending on the context.  
Note: It’s possible to build an enormous variety of charts in Tableau, Show Me is 
one-click options, not a comprehensive list of possibilities.  

3) Show Me creates a view based on the fields already used in the view and any 
fields you’ve selected in the Data pane.  

4) Tableau automatically evaluates the selected fields and gives you the option of 
several types of views that would be appropriate for those fields. Show Me also 
highlights the visualization type with orange color that best matches the data. 

5) Chart types that are not applicable to your worksheet as it is currently 
constructed will be grayed out and not selectable until you have the appropriate 
combination of measures and/or dimensions. 

6) Any view type that is not greyed out will generate a view of your data. As you 
hover over each view type, the description at the bottom shows the minimum 
requirements. 

7) In this example, because a date dimension and a measure are selected, Tableau 
suggests you build a line view. A line is often the optimal way to look at how 
measure values change over time.  
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Activity 2.2.1   Visualizing yearly total charges via bar chart  
Question: There are 13,178 record rows in the Excel spreadsheet file. What is the total 
number of charges each year? How did one year compare to the other two years?  
  

1) Create a new worksheet by clicking on New Worksheet button . 
2) Drag Number of Charges from Measures to the Rows shelf  

a. When we bring a field into the view from the data pane, Tableau creates a pill.  
b. The Number of Charges field is colored green on the Rows shelf, indicating that 

it is continuous.  
c. The field name changes to SUM(Number of Charges). That’s because 

measures are automatically aggregated when you add them to the view, and the 
default aggregation for this measure is SUM.  
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d. If you right-click over SUM(Number of Charges), select Measure (Sum), you 
will see all the Aggregate functions available for this measure. 

 
i. SUM - Returns the sum of all values in the expression.  
ii. AVG - Returns the average of all the values in the expression (i.e. the 

sum of a collection of numbers divided by the number of numbers in the 
collection.). In our example, SUM (number of charges) / COUNT (number 
of charges) = 1 

iii. COUNT - Returns the number of items in a group. In our example, the 
count number is the same as the sum number.  

iv. COUNTD - Returns the number of distinct items in a group. In our 
example COUNTD is 1.  

v. Read more at Aggregate Functions in Tableau .  
3) Drag Time Charge from Dimensions to the Columns shelf, and change the Marks to 

from Automatic to Bar. 
a. When you drag a field over a shelf, a plus sign indicates that the shelf can accept 

the field. 
b. Notice that the field is colored blue, which indicates that it is discrete. 
c. Dimensions set the granularity, or the level of detail in the view. What dimensions 

we use to build the view will determine how many marks we have. Here we have 
3 years of data, 2014-2016 – and we have 3 marks.  

d. The default date level is determined by the highest level that contains more than 
one distinct value (for example, multiple years and multiple months). That means 
that if [Time Charge] contained data for only one year but had multiple months, 
the default level would be month. You can change the date level using the field 



 15 

menu. 

 
 

4) On the field drop down menu, the first set is for discrete date levels and the second list is 
for continuous date levels. Discrete means data is individually separate and distinct. 
Continuous means data can take any value in a range, forming an unbroken 
whole, without interruption. Dates can be brought into the view as either continuous or 
discrete. Tableau is very smart about creating Date and Time hierarchy automatically. 
You can conveniently traverse (drill down and scroll up) along Tableau generated Date 
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and Time Hierarchy and watch change on numbers.  

 
5) Right click over Sheet 2 and rename it to DMC-Charges-by-Year. 
6) Optional steps 

a. Right click over the sheet name, choose Duplicate as Crosstab, you will get a 
text table(Crosstab) just like the one created in the previous activity. The text 
table shows the numbers visualized in the view. Right click over the sheet name, 
choose Delete to delete the sheet.  

b. Or click on Show Me, choose text tables, you will get the same text table as the 
action of Duplicate as Crosstab.  

Activity 2.2.2 Visualizing monthly charges across years via bar chart (one 
dimension and one measure) 
Question: What is the total number of charges each month across years? 
 

1) Click  to create a new worksheet.  
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2) Drag Number of Charges from Measures to the Rows shelf and Time Charge from 
Dimensions to the Columns shelf, and make sure Bar is selected in the Marks Pull-
down menu. 

3) Click the Down arrow in the YEAR(Time Charge) pill on the Columns shelf and select 
Month (the first one, the Discrete one)  

4) You will get checkout numbers by month across all the years (2014 - 2016)   

 
5) Rename the sheet to DMC-Charges-by-Month. 

 

Activity 2.2.3 Visualizing weekly charges across years via bar chart  
(DIY activity) 

1) Click  to create a new worksheet.  
2) Drag Number of Charges from Measures to the Rows shelf and Time Charge from 

Dimensions to the Columns shelf, and make sure Bar is selected in the Marks Pull-
down menu. 

3) Choose Weekday this time. 
4) You will get checkout numbers by Weekday across all the years (2014 -2016).  
5) Rename the sheet to DMC-Charges-by-Weekday. 

Activity 2.2.4 Visualizing hourly charges across years via bar chart 
(DIY activity) 

1) Right click over the sheet of DMC-Charges-by-Weekday 
2) Select Duplicate 
3) Click the Down arrow in the Year(Time Charge) pill on the Columns shelf, select More 

and click Hour 
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4) You will get checkout numbers by Hour across all the years (2014 -2016). 
5) Rename the sheet to DMC-Charges-by-Hour. 

Activity 2.2.5 Sorting data  

• In the DMC-Charges-By-Hour, click  Swap Rows and Columns button on the 
toolbar to make the bars horizontal.  

• Hover over the mouse over the sort icon . One click sorts 
the data in ascending order. Two clicks sorts it in descending order. Three clicks clear 
the custom sort, setting it back to the default sort method. 

• Or on the toolbar, click the Descending sort icon  to sort data from highest/most to 

lowest/least, or the Ascending icon  to do the other way around.  
• Or select an hour in a header and drag it up or down, the viz updates with the new sort. 

 
In any way, Tableau provides a visual indication that a customized sort is applied. A sort 
icon appears on the HOUR(Time Charge) (on rows). 
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III.  Use Marks card to add depth to your chart 
Activity 3.1 Visualizing yearly charges and user profile via bar chart (two 
dimensions and one measure) 
Question: What is the total charges each year and how had different user groups 
checked out equipment? 

1) Click  to create a new worksheet.  
2) Drag Number of Charges from Measures to the Rows shelf and Time Charge from 

Dimensions to the Columns shelf, and make sure Bar is selected in the Marks Pull-
down menu. 

3) Drag and drop User Profile from Dimensions on to the Color card in the Marks pane.   
Note: The Marks card is where you drag fields to control mark properties such as type, 
color, size, shape, and so on.  

4) You can get the following screen.  The Color legend is on the far right side. 

 
5) Placing a dimension on Color separates the marks according to the members in the 

dimension, and assigns a unique color to each member. The color legend displays each 
member name and its associated color. 

6) Rename the sheet to DMC-Charges-by-Year-and-UserProfile. 
 

Activity 3.2 Visualizing yearly charges and device name via circle chart 
(DIY activity) 
Question: What is the total charges each year and how had different devices been 
checked out? 

1) Click  to create a new worksheet.  
2) Drag Number of Charges from Measures to the Rows shelf and Time Charge from 

Dimensions to the Columns shelf. 
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3) Select Circle in the Marks Pull-down menu.  
4) Drag Title/Call No. on to the Color card. Then drag Number of Charges on to the Size 

card. If you see the following dialog window, please click Add all members. 

 
5) You can also click the Size card to adjust the size of circle via the popped up Size 

selection slider.  

 
6) Rename the sheet to DMC-Charges-by-Year-by-DeviceName.  

 

Activity 3.3 Visualizing yearly charges, devices, and user profile via Text 
Table 
(DIY activity) 
 

1) Click  to create a new worksheet.  
2) Drag Number of Charges from Measures to the Rows shelf and Time Charge from 

Dimensions to the Columns shelf. 
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3) Click the text tables button on the Show Me Tool Bar. 

  
4) Now you get statistics for each year in tabular format 

 
5) Drag User Profile and Title/Call No.  one after each other on to the Rows shelf. 

 
6) Rename the sheet to DMC-Statistics-by-YearUserProfileTitle. 

 

IV.  Drill down into the Data 
Drilling down usually means expanding out a hierarchy, getting to the next level of 
detail. When you connect to a data source, Tableau automatically separates date fields 
into hierarchies so you can easily break down the viz. 
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Activity 4.1 Drilling down date hierarchy with the DMC-Charges-by-Year 
chart 
You can modify the view to show quarters, month, etc. in addition to years. As you drill 
down into the hierarchy, the view changes to become a nested table. 

1) Right click over the sheet of DMC-Charges-By-Year. 
2) Select Duplicate. 

3) Click the plus button   on the left side of the 
field YEAR(Time Charge) field on Columns or Drag the Time Charge field (again) from 
the Data pane and drop it on the Columns shelf to the right of Year(Time Charge).  

4) The new dimension divides the view into separate panes for each year. 
5) You can further drill into months. And delete QUARTER(Time Charges) from the 

Columns shelf.  

 
6) Rename the sheet to DMC-Charges-by-Year-Month 
7) Switch YEAR(Time Charge) and MONTH(TIME Charge) in Rows by dragging 

MONTH(TIME Charge) to the front of YEAR(Time Charge), you will see the nested table 
is changed to the view below. Tableau generates a view based on where and in what 
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order you drag and drop fields into the shelf. 

 

8) Click Undo button  on the toolbar to undo the change.  
 

Activity 4.2 Creating groups and drillable hierarchy  
You can also create your own custom hierarchies. For example, if you have a set of 
fields named Region, State, and County, you can create a hierarchy from these fields so 
that you can quickly drill down between levels in the viz. 
 
Activity 4.2.1 Create Groups 
In this example of DMC equipment data, we don’t have a set of fields that we can create 
a meaningful hierarchy. We will create a group, then we will create a hierarchy.  
 
Group simplifies large numbers of dimension members by combining them into higher-
level categories. The field “User Profile” has too many members. Let’s bring it down to 4 
groups (i.e. students, faculty, staff, and others.). This creates a higher level category.  
 

1) Drag Time Charge to Columns shelf, Number of Records to Rows shelf, and User 
Profile to the Color Marks.  
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2) Click Show Me, choose text tables. 

 
3) Select GRAD, GRADUATE14, GRADUATE15, GRADUATE16, GRADUATE17, 

UNDERGRAD, mouse over any selected labels and select the paperclip icon to Group 
members. 
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4) Right click over the label and select Edit Alias…, rename it to STUDENTS. 

 
5) You will see a new dimension User Profile (group) is created and put under Dimensions. 

Right click over its name and rename it to User Profile Groupings.  
6) Create groups within the Edit Group dialog. 

o Right click on User Profile Groupings in the Dimensions. 
o Select Edit Group… 
o Multi-select INACTIVE, INSIDE15, LIBRARYUSE, OUTSIDE4, OUTSIDE15, 

TERMINATED 
o Click on Group 

 
o Rename the group to OTHERS.  
o Click Apply, then click OK. 
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o You will get a view like below.  

 
o Click Show Me, choose Stacked bars chart. 

7) Rename the sheet to DMC-Charges-by-Years-by-UserProfileGroupings.  
8) Click on the drop-down menu of User Profile Groupings, choose Edit Colors->Color 

Blind, change the color for the four different groups.  
 

 
 

  
Activity 4.2.2 Form hierarchies 



 27 

Hierarchies give end users the option to look at data at a high level or drill down into more 
detailed levels. We will create a hierarchy with User Profile Groupings and User Profile. Since 
‘User Profile Groupings’ is a higher level of categorization of ‘User Profile’, it makes sense to 
have this before ‘User Profile’, on the top of the hierarchy. 

1) Under Dimensions, drag User Profile on top of User Profile Groupings. 

 
2) Change the name of the hierarchy to User Profile Hierarchy.  

 
3) Build a view by dragging Number of Records to Columns shelf and User Profile 

Groupings to Rows shelf. You will see the + sign in front of the User Profile Groupings 
pill. 
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4) You can now drill down to the next more detailed level by clicking on the + on the pill in 
Rows or the + will appear if you mouse over any of the labels in the view.  

 
5) Rename the sheet to DMC-Charges-by-Groups. 

 

V. Filter data from your view 
Filter allows you to show a subset of the data so that you can focus your analysis.  
Activity 5.1 Create a filter 

1) Create a new worksheet. 
2) Drag Number of Charges to the Rows shelf, Time Charge and User Profile 

Groupings to the Columns shelf. 
3) Drag User Profile Groupings to Filters shelf.  
4) Right click over the User Profile Groupings in the Filters shelf, choose Show 

Filter.  
5) Play with the settings and see how the filter changes the view. 
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6) Rename the sheet DMC-Charges-Filtered. 

 

Activity 5.2 Understanding how Tableau works 
Every chart/view that you create in Tableau should start with a question. What do you want to 
know? Every time you drag a field from the Data pane onto the cards and shelves, you are 
asking a question about the data and you are forming a Visual Query Language (VizQL) that 
Tableau generates based on where and in what order you drag and drop fields into the view. 
Then Tableau translates the VizQL into SQL/MDX/RQL (Structured Query Language/ 
MultiDimensional eXpressions/Resource Query Language) and issues it as a query to the data, 
gets back the results, and renders the visualization.  
An example of SQL syntax: SUM function when grouping the results by one or more columns is: 
SELECT expression1, expression2, ... expression_n,        

 SUM(aggregate_expression)  
FROM tables 
 [WHERE conditions] 
 GROUP BY expression1, expression2, ... expression_n; 
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Figure: How Tableau Works 
 
 
For every question you ask, the view changes to represent the answer visually - with marks 
(shapes, text, hierarchies, table structures, axes, color). 
 

VI.  Use Dashboard to uncover key insights 
Activity 6.0 Can you create a worksheet to show which user group checked 
out what type of equipment over years? 
DIY activity.  
 
A dashboard is a collection of several worksheets in a single place so that you can 
compare and monitor a variety of data simultaneously. Dashboard is all about 
interactivity among worksheets.  
Activity 6.1 Create a Dashboard 

1) Click  to create a dashboard.  
2) Click on Size, from the drop down menu, choose Automatic, the dashboard will resize for 

any screen it is displayed on.  
3) Drag Sheet DMC-Charges-by-Year-by-UserProfileGroupings and DMC-Charges-by-

Year-by-DeviceName from the Sheets section and drop them one by one onto the blank 
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Drag and 
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Visualization 
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dashboard canvas.  

 
 

4) We can close the window of the Number of Charges and Title/Call No. by clicking on 
the Cross button. 

5) Click Show dashboard title in the Objects section at the lower left corner. 
6) Double click the default and change the default title text to Insights into DMC 

Equipment Circulation Data and center the new title in the popped up Edit Title rich 
text editor. 
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7) Now your dashboard looks like below.  

 
 

Activity 6.2 Use the top worksheet as a driver to filter the worksheets below 

1) Click to select the top sheet. Click on the Funnel icon  on the upper right corner of 

the top chart, the Funnel icon turns into white . This enables the top chart to filter 
all the worksheets in the dashboard.  

2) Click 2015 in the first chart, the second chart will only display 2015 statistics by 
Title/Call No. Click 2015 again will cancel out the selection and return to the previous 
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view. 

 

3) Click the Funnel icon  to turn the filter function off .  
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Activity 6.3 Create a filter to enable interactivities with end users 
Goal: We want our end-users to be able to select a value in User Profile Groupings.  

1) Click on the Down Arrow button next to the Funnel icon on the top worksheet and 
select filters and then the User Profile Groupings. 

 
2) Now you will see a new checkbox list for User Profile Groupings.  Click the Down arrow 

on the top border of the checkbox list and select Single Value (dropdown) or Multiple 
Values(dropdown).  

3) Click the same down arrow again and select Floating and drag the filter dropbox to the 
place you like. 
 

4) Click the same down arrow again, select Apply to Worksheets->All Using This Data 
Source. 
 

5) Change the filter title to Select a User Group by double clicking the filter pane and 
making the change.  
 
 

Activity 5.4 Customize the look of the Dashboard 
1) Drag Image from Objects pane and drop it to the top of the dashboard, this opens a file 

selection window, choose DMC logo blue.png file. Then set it to Floating and Fit 
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image.  

 
2) Click on Set URL…, to set it to http://library.rice.edu/dmc 
3) Drag Blank from Objects pane and drop it to the top of the dashboard. Adjust its height. 
4) Change the setting for the dashboard title to Floating and adjust its position.  
5) The final view of dashboard would look like below 

 
6) Starting Tableau version 10, you can change font for the whole workbook in one place. 

Click Format in the Top menu Bar, then select WorkBook… . Try changing some font 
settings with the popped up Format Workbook menu.  

7) Rename the Dashboard to DMC-Equipment-Charges-Dashboard. 
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VII.  Use Story to present your analysis  
You can tell stories with your data using dashboards or using Story function. A story is a 
sheet that contains a sequence of worksheets or dashboards that work together to 
convey information. 

Activity 7.1 Create a Story 

1) Click the new Story button  or Story -> New Story 
2) Click on Size, change it to Automatic.  
3) You open a new story pane. You may drag your any worksheet or dashboard created 

earlier into this pane.  
4) Drag DMC-Charges-By-Year into the pane. 
5) Double click Add a caption and add a caption title - DMC Equipment Circulation Data 

for the Year of 2014, 2015, and 2016.  
6) Double click the default Story title Story 1 and change it to How had the DMC 

equipment been checked out for the year of 2014, 2015, and 2016? You can add 
descriptive text to this story pane by clicking the A Description and entering your 
paragraph.   

7) Now you first Story point may look similar to below.  

 
8) Now we can add a new blank story point by clicking Blank button on the left pane.   
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9) Drag the DMC-Charges-By-Month sheet onto this 2nd story pane, change caption title 
to DMC Equipment Circulation Data by Month across the years of 2014 through 
2016. Add a comment as you like.  

10) Following the similar steps, we can add the 3rd and fourth story point pages. Now you 

click on  Presentation Mode button on the toolbar to play the story. User can 
browse the story page by clicking through the navigation bar.  

11) You can change Story formats like Font, Color and etc. by clicking Format in the Top 
menu bar and then choosing Story… 

12) Rename the Story to DMC-Equipment-Circulation-Story. 
  

VII. Save and publish your work 
Now, so far all the work you have completed in your Tableau desktop is not saved and you need 
to do it now. You can’t save your work locally. With a free account on Tableau Public, you have 
10GB storage.  

1) File -> Save to Tableau Public 
2) Enter Tableau Public account and password 

a. DMC Tableau Public training account: erc@rice.edu 
b. Password:  

3) Type a name for the workbook and click Save 
4) Follow the on-screen prompts to save your Tableau Workbook and publish it. This will 

take a minute or so depending on your project size.  
5) Now you should be taken to the confirmation page in your Tableau Public user profile 

in an opened browser. 
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6) You can click the Edit Details link shown in the above dialog to change metadata 
settings for your published Viz. 

  
7) Note that under Toolbar Settings, if you checked “Allow workbook and its data to be 

downloaded by others”, when users view worksheet, they will be able to download both 
workbook and its data. 

 . 
However, if users view a Dashboard, they still have Crosstab and Data options greyed 
out.  
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8) "Viz" can be a worksheet or dashboard and stories. Workbooks hold one or more 

worksheets, dashboards and Stories. As soon as a workbook is published to Tableau 
Public, the viz and its workbook are accessible by anyone on the internet, so be 
sure to only use data that is suitable for a public audience.  

9) Customize your profile 
a. Click My Profile 

 
b. Mouse over a Viz. You can feature it, hide it, download it, or trash it.  
c. Select View to open the Viz.  

i. Then you can select Edit Details to customize metadata such as 
workbook name and description, etc. 
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ii. Or click Share button at the lower right corner to get a link to share 
with others or code to embed in a web page

 
iii. Download Workbook button at the upper right corner to download 

the workbook.  
iv. Download at the lower right corner to download the workbook, data, 

PDF, or image.  
 

 
 
Resources 

1) Tableau Public How-to-videos 
https://public.tableau.com/en-us/s/resources 

2) Get Started with Tableau Desktop 
http://onlinehelp.tableau.com/current/guides/get-started-tutorial/en-us/get-started-
tutorial-home.html 

3) Knowledge base  
https://www.tableau.com/support/knowledgebase 

4) Tableau online help documentation 
http://onlinehelp.tableau.com/current/pro/desktop/en-us/help.html 
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5) Tableau Sample Data Sets - A changing sample of datasets for use in teaching 
and learning.  https://public.tableau.com/s/resources?qt-overview_resources=1 - 
qt-overview_resources 

6) Datasets in public domain at Inside Airbnb http://insideairbnb.com/get-the-
data.html 

7) Datasets for Teaching and Learning 
http://libguides.rice.edu/data_resources/samples 

8) Tableau Essentials: Chart Types – Introduction 
https://interworks.com/blog/ccapitula/2014/08/04/tableau-essentials-chart-types-
introduction/ 
 


